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ISIRI 
(1960)

Institute of 
Standards and 
Industrial 
Research of Iran

BSI 
(1902)

CSA
Canadian 
standard 

Association

DIN 
(1917)

Deutsches Institut 
für Normung

ISA 
(1926)

ISO - International Standard Organization (1947)
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Ernst Neufert (1936)
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کشی متداول استدر نقشه
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Technical drawing pen size: 

https://www.designingbuildings.co.uk/wiki/Paper_Sizes

Note: m ISO = metric ISO
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https://www.easynotecards.com/notecard_set/49991

https://engineeringdrawingbasics.com/different-line-types-used-on-engineering-drawings/

https://www.google.com/url?sa=i&url=https%3A%2F%2Fwww.koraputiti.in%2Fcategory%2Fclass-

notice%2Fnotes%2Fengineering-drawing%2F&psig=AOvVaw0DYmIKU0WGczzTryn-

ti1E&ust=1665496966544000&source=images&cd=vfe&ved=0CA0QjhxqFwoTCODsxerp1foCFQA

AAAAdAAAAABAh
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گونیای ثابت گونیای متغیر

گونیا
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رسم کرد چیست؟45و 60-30توان با گونیای ای که میحداقل زاویه
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خط کش تی
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تخته رسم کشیمیز نقشه

کشی و تخته رسممیز نقشه
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اشل

https://sazeplus.com/product/scale-dwg/
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پرگار

هابرای انتقال اندازه: گیرپرگار اندازه
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شمنحنی ک-شابلون پیستوله

ماری کش

شابلون

شابلون معماری

کنشابلون پاک
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نقاله
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برس
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چسب

چسب کاغذیچسب کالک

یچسب پلاستیک
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درفتینگ
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کاغذ

کاغذ کالک کاغذ پوستی کاغذ سفید
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کاغذ

(های اسکچبرای نقشه)کاغذ شطرنجی  کاغذ میلیمتری

کاغذ ایزومتریک

کاغذ لگاریتمی
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Dr. Walter Porstmann (1886-1959)

The ISO 216 standard defines the "A" and "B" series of paper sizes.

The ISO 269 "C" series is commonly listed alongside the A and B sizes.

The area of B size sheets are the geometric mean of successive A-series

sheets. For instance, the area of the B1 sheet (0.707 m²) is in between A0 (1

m²) and A1 (0.5 m²). The B Series is used for passports, envelopes and

posters. B5 has become a conventional size for many books.

The entire C-series suite of envelopes are designed to hold their A-series’

counterparts, and are defined by ISO 269. The area of C series sheets is

the geometric mean of the areas of the A and B series sheets of the same

number. So, the area of a C4 sheet is the geometric mean of the areas of an

A4 sheet and a B4 sheet.

The A-series was derived from a rectangle piece of paper (A0) having

an area of 1 m2, the length of whose sides are in the proportion 1:√2 (1:

1.4142).

Paper Size: 

https://www.designingbuildings.co.uk/wiki/Paper_Sizes
The advantages of basing

a paper size on an aspect ratio

of √2 was first noted in 1786

by the German scientist and

philosopher Georg Christoph

Lichtenberg.
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1189

841
= 2
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https://www.digitalprinting.co.uk/support/paper-weight-

guide/#:~:text=80%20%E2%80%93%20100gsm%3A%20The%20weight%20range,as%20letterheads%20and%20compliment%20slips.
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https://slidetodoc.com/chapter-1-introduction-contents-engineering-drawing-

drawing-standards/
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Engineering drawing and design
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رسم عمود بر
یک خط
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رسم عمود بر یک خط
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رسم عمود بر یک خط
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رسم دایره  
گذرنده از  
سه نقطه
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رسم دایره گذرنده از 
سه نقطه
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پیدا کردن  
مرکز دایره
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ا  رسم مثلت ب
ه  استفاده از س
ضلع معلوم
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رسم مثلت با داشتن
سه پاره خط
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رسم نیمساز
زاویه
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D

نیمساز زاویهرسم 
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رسم خط 
موازی

سوندیرسم فنی ساختمان، مهندس محمد شاه



52

خط موازیرسم 
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تقسیم خط 
قسمت nبه 

مساوی
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قسمت مساویnتقسیم خط به 
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رسم  
چندضلعی  

منتظم

سوندیرسم فنی ساختمان، مهندس محمد شاه



56

سه ضلعی منتظم
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چهار ضلعی منتظم
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شش ضلعی منتظم
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شش ضلعی منتظم
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هشت ضلعی منتظم
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چند ضلعی منتظم
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ه  ترسیم دایر
...مماس بر 
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ترسیم دایره مماس بر دو خط
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ترسیم دایره مماس بر خط و دایره
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ترسیم دایره مماس خارجی بر دو دایره
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ترسیم دایره مماس داخلی بر دو دایره
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(مماس داخلی و خارجی)ترسیم دایره مماس  بر دو دایره 
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https://www.google.com/search?q=3d%20cad%20exercises&tbm=isch&hl=en&tbs=rimg:CV_1TNSEBHeazYR3baddpL3znsgITCgII

ABAAOgQIARAAQAFVhTgLP8ACANgCAOACAA&sa=X&ved=0CBoQuIIBahcKEwiA0cjklI-

CAxUAAAAAHQAAAAAQBw&biw=1269&bih=608
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https://grabcad.com/library/3d-cad-exercises-practice-944-catia-1
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https://www.vvsd.org/cms/lib/IL01905528/Centricity/Domain/3480/ALPHABET%20OF%20LINES.pptx
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انواع فرجه، خط و صفحه
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، خط و صفحه(ناحیه)فرجه 

https://rockbench.ir/drawing-03/
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https://raman01.ir/analysis-view-and-volume/
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https://rockbench.ir/drawing-03/

(فرجه سوم)و در استاندارد آمریکایی ( برای فرجه اول)ISO. در نقشه کشی صنعتی فرجه اول و سوم کاربرد دارد
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باشد دارای اندازهموازی اگر خطی با صفحات اصلی 
.حقیقی در آن تصویر است

ه  است، تصویرش یک نقطعمود خطی که بر صفحه 
.خواهد بود

:انواع خط
(عمود بر صفحه افقی)خط قائم -1
(عمود بر صفحه جانبی)خط مواجه -2
(عمود بر صفحه قائم)منتصب خط -3
(موازی صفحه قائم)جبهیه /خط جبهی-4
(موازی صفحه جانبی)خط نیمرخ -5
(موازی صفحه افقی)خط افقیه -6
(نه موازی و نه عمود)خط غیرخاص -7
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ه  گروه دیگر خط و صفحه هایی هستند که نسبت ب
.صفحات اصلی تصویر زاویه دارند

:انواع خط
(عمود بر صفحه افقی)خط قائم -1
(عمود بر صفحه جانبی)خط مواجه -2
(عمود بر صفحه قائم)منتصب خط -3
(موازی صفحه قائم)جبهیه /خط جبهی-4
(موازی صفحه جانبی)خط نیمرخ -5
(موازی صفحه افقی)خط افقیه -6
(نه موازی و نه عمود)خط غیرخاص -7
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د دارای  صفحاتی که با صفحه اصلی تصویر موازی باشن
.تصویر حقیقی هستند

:انواع صفحه

جبهیه/ صفحه جبهی-1
صفحه نیمرخ-2
صفحه افقی-3
صفحه منتصب-4
صفحه مواجه-5
صفحه قائم-6
(نه عمود و نه موازی)صفحه غیرخاص -7
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.در احجام صفحات شیب دار هم کاربرد زیادی دارند

:انواع صفحه

جبهیه/ صفحه جبهی-1
صفحه نیمرخ-2
صفحه افقی-3
صفحه منتصب-4
صفحه مواجه-5
صفحه قائم-6
(نه عمود و نه موازی)صفحه غیرخاص -7
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https://raman01.ir/%D9%BE%D9%88%D8%AF%D9%85%D8%A7%D9%86-%D8%B3%D9%88%D9%85-%D8%AA%D8%B1%D8%B3%DB%8C%D9%85-%D8%B3%D9%87-

%E2%80%8C%D9%86%D9%85%D8%A7-%D9%88-%D8%AD%D8%AC%D9%85/
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https://rockbench.ir/drawing-04/
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https://rockbench.ir/drawing-04/
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یابینقطه
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https://raman01.ir/%D9%BE%D9%88%D8%AF%D9%85%D8%A7%D9%86-%D8%B3%D9%88%D9%85-%D8%AA%D8%B1%D8%B3%DB%8C%D9%85-%D8%B3%D9%87-

%E2%80%8C%D9%86%D9%85%D8%A7-%D9%88-%D8%AD%D8%AC%D9%85/
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https://raman01.ir/%D9%BE%D9%88%D8%AF%D9%85%D8%A7%D9%86-%D8%B3%D9%88%D9%85-%D8%AA%D8%B1%D8%B3%DB%8C%D9%85-%D8%B3%D9%87-

%E2%80%8C%D9%86%D9%85%D8%A7-%D9%88-%D8%AD%D8%AC%D9%85/
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https://raman01.ir/%D9%BE%D9%88%D8%AF%D9%85%D8%A7%D9%86-%D8%B3%D9%88%D9%85-%D8%AA%D8%B1%D8%B3%DB%8C%D9%85-%D8%B3%D9%87-

%E2%80%8C%D9%86%D9%85%D8%A7-%D9%88-%D8%AD%D8%AC%D9%85/

سوندیرسم فنی ساختمان، مهندس محمد شاه



106

ه  گروه دیگر خط و صفحه هایی هستند که نسبت ب
.صفحات اصلی تصویر زاویه دارند

:انواع خط
(عمود بر صفحه افقی)خط قائم -1
(عمود بر صفحه جانبی)خط مواجه -2
(عمود بر صفحه قائم)منتصب خط -3
(موازی صفحه قائم)جبهیه /خط جبهی-4
(موازی صفحه جانبی)خط نیمرخ -5
(موازی صفحه افقی)خط افقیه -6
(نه موازی و نه عمود)خط غیرخاص -7
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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https://rockbench.ir/drawing-04/

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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φ50

60

φ20
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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تصاویر مجسم

https://rockbench.ir/drawing-10/

.شوندمیزاویه محورها به سه دسته تقسیم تصاویر مجسم بر اساس

سوندیرسم فنی ساختمان، مهندس محمد شاه
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Computer-Aided Design

John Walker

developed by the French company Dassault Systèmes

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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رسم نما

سوندیرسم فنی ساختمان، مهندس محمد شاه
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رسم برش

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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1-1
تاریخچه•

1-2
زارنمایی‌شماتیک‌از‌پنجره‌اصلی‌و‌میله‌ابزارهای‌نرم‌اف•

1-3
عملکرد‌موس‌و‌کیبورد•

1-4
تعاریف‌عمومی•

سوندیرسم فنی ساختمان، مهندس محمد شاه
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صفحه ترسیم

اشاره گر موس

محور مختصات  
(UCS Center)

های دستورهاپانل

هازبانه (InfoCenter)مرکز اطلاعات 
نوار ابزار دستری سریع  

(Quick Access Toolbar)

خط فرمان
(Command Line)

روبان 
(Ribbon)

(Title Bar)نوار عنوان 

شتعیین حالت نمای

نوار وضعیت
(Status Bar)

سوندیرسم فنی ساختمان، مهندس محمد شاه
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موس و کیبوردعملکرد 1-3

شودمیاستفادهاتوکددرجداولوهاپیغامموضوعات،ها،آیکنانتخاببرایکلیدایناز:موسچپکلیدعملکرد.

:شویدمیمواجهزیرحالتدوباصفحه،درنگهداشتنوکردنکلیکازپسموضوعات،انتخاببرای

قرارانتخابموردراآنهاموضوعات،بامستطیلبرخوردکوچکترینباکهشودمیظاهرسبزمستطیلچپ،سمتبهموسحرکتصورتدر.۱
.دهدمی
موردراگیرندمیقرارمستطیلایندرونکاملطوربهکهموضوعاتیتنهاکهشودمیظاهرآبیمستطیلدهید،حرکتراستسمتبهراموساگر.2

.دهدمیقرارانتخاب

انتخابحالتازراموضوعاتموس،چپکلیدازاستفادهباوداشتهنگهپایینراShiftکلیدانتخاب،حالتازموضوعاتازبرخیکردنخارجبرای
.کنیدخارج

سوندیرسم فنی ساختمان، مهندس محمد شاه
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موسوسطکلیدعملکردهای(Scroll):

میگفتهzoomآنبهاصطلاحاًکهکردهتغییرصفحهبزرگنمایی،عقبیاجلوسمتبهکلیدایندادنحرکتبا.۱
.شود
بهاصطلاحاکهشدهجابجاکارییصفحهدهیم،حرکتراموسودادهفشارپایینسمتبهراموسوسطکلیداگر.2
.شودمیگفتهPanآن
عملاینبهاصطلاحاًکهگیردمیقرارکاربردیدکانونییمحدودهدرموضوعاتتمامیکلید،ایندادنفشاردوباربا.3

zoom extendشودمیگفته.
.دادحرکتانیمیشنیصورتبهراصفحهتوانمی،ScrollرویبرکلیکوCtrlکلیدداشتننگهبا.4
.کردمنتقلبعدیسهمحیطبهرانماتوانمیScrollرویبرکلیکوshiftکلیدداشتننگهبا.5

کلیدEnter & Space bar:گیردمیقراراستفادهموردموضوعاتکردنتکراروتثبیتتایید،برایکلیددوهر.
کلیدEsc:برایCancelگیردمیقراراستفادهموردهاوپیغامجداولدستورات،کردن.
کلیدCtrl+ Tab:گیردمیقراراستفادهموردشدهبازهایفایلتمامیبینشدنجابجابرای.

.نموداستفادهصفحاتبینشدنجابجابرایتوانمینیزWindowسربرگاز

سوندیرسم فنی ساختمان، مهندس محمد شاه
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کلیدهای:تابعکلیدهایF1تاF12استزیرصورتبهآنهاازبرخیعملکردگویندکهتابعکلیدهایرا.
۱.F1:کردنبازبرایHelpافزارنرم.
2.F2:بیشترجزئیاتبافرمانخطدادننشانبرای.
3.F4&F3:کردنفعالغیریافعالبرایObject Snapها.
4.F7:طراحیفضایشطرنجییزمینهپسکردنفعالغیریافعالمنظوربه.
5.F8:کردنفعالغیریافعالبرایOrthoنمودرسمعمودییاافقیصورتبهراخطتوانمیتنهاکلید،اینبودنفعالصورتدر.شودمیاستفاده.
6.F9:رویبرفقطموسنشانگرکلیداینبودنفعالصورتدرgridکندمیحرکت(طراحیفضایدرمشبکخطوط)ها.
7.F10:کردنغیرفعالیافعالبرایکلیداینازpolarشودمیاستفاده.

سوندیرسم فنی ساختمان، مهندس محمد شاه
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استشدهدادهتوضیحزیردرآنهایعملکردازبرخیکهکردهباززیرصورتبهایصفحهمنوییک:موسراستکلیدعملکرد.

سوندیرسم فنی ساختمان، مهندس محمد شاه
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Ctrl+9

In Command Type: MENUBAR

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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3-1
AutoCADفضاهای‌کاری‌در‌نرم‌افزار‌•

3-2 جدیدی‌صفحهباز‌کردن‌ی‌طریقه•

3-3 ابزارمیلهایجاد‌ی‌طریقه•

3-4 زمینهپستغییر‌رنگ‌ی‌طریقه•

3-5 اجرای‌دستوراتهای‌روش•

3-6 تکرار‌دستوراتهای‌روش•

سوندیرسم فنی ساختمان، مهندس محمد شاه
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AutoCADفضاهای کاری در نرم 3-1

:به‌صورت‌زیر‌می‌باشدAutoCADفضاهای‌مختلف‌طراحی‌در‌

اتوکد‌شد‌نرم‌افزار‌وارد‌محیط‌می‌توان‌روش‌4به‌

workspaceطریق‌میله‌ابزار‌از-۱

بالای‌صفحه‌ribbonاز‌طریق-2
workspacesانتخاب‌و‌toolsبر‌روی‌منویکلیک‌-3

 (work space switching)از‌آیکن‌چرخ‌دنده‌در‌پایین‌صفحه-4

سوندیرسم فنی ساختمان، مهندس محمد شاه
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جدیدی صفحهباز کردن ی طریقه3-2

.کلیک‌کنید..Newکلیک‌کرده‌و‌سپس‌از‌پنجره‌ی‌ظاهرشده‌بر‌روی‌گزینه‌یFileبرای‌باز‌کردن‌صفحه‌ی‌جدید‌ابتدا‌بر‌روی‌گزینه‌ی‌

یگزینهانتخابباتوانیممیشودمیبازبالاشکلمطابقکهایپنجرهدر
acadاینچواحدباجدیدیصفحهیک(inches)کنیمباز

بایستمیمیلیمترواحدباصفحاتکردنبازبرایکهاستذکربهلازم
.کنیمکلیکacadisoیگزینهرویبر

model)طراحیفضایواحدنوعازآگاهیبرای space)منویاز
formatیگزینهunits…دروشدهظاهریپنجرهدر،کردهانتخابرا
Unitsقسمت to scale inserted contentنشانصفحهواحدنوع
استشدهداده

سوندیرسم فنی ساختمان، مهندس محمد شاه
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ایجاد میله ابزاری طریقه3-3

:میله‌ابزارها‌را‌درون‌اتوکد‌ایجاد‌کردتوان‌زیر‌میبه‌سه‌روش‌

.ها‌آیکنراست‌بر‌روی‌کلیک‌-۱

.خاکستری‌اتوکدی‌حاشیهراست‌بر‌روی‌کلیک‌-2

.AutoCADوسپس‌انتخاب‌toolbarsی‌گزینهو‌انتخاب‌toolبرروی‌منوی‌کلیک‌-3

backgroundیا زمینه پستغییر رنگ ی طریقه3-4

:کنیممیتغییر‌رنگ‌پس‌زمینه‌مراحل‌زیر‌را‌دنبال‌برای‌

سوندیرسم فنی ساختمان، مهندس محمد شاه
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اجرای دستوراتهای روش3-5

:دستورات‌را‌در‌اتوکد‌اجرا‌نمودتوان‌میزیر‌های‌روشبه‌

فرمانخط‌-۱

...(و،،‌)‌آیکون‌-2

خلاصهحرف‌-3

ترکیبیکلیدهای‌-4

باتوانندمیکاربرانکهشدهظاهردستوراتخلاصهحرف(Alt)کلیدداشتننگهبا
.کنندظاهرراآنیپنجرهمربوطه،کلیدفشردن

سوندیرسم فنی ساختمان، مهندس محمد شاه
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بالای‌صفحهمنوی‌-5

تکرار دستوراتهای روش3-6

:زیر‌استتکرار‌دستورات‌در‌اتوکد‌به‌صورت‌های‌روش

Enterکلید‌-۱

Spaceکلید‌-2

… Repeatکلیک‌راست‌در‌صفحه‌و‌انتخاب‌-3

recent inputکلیک‌راست‌در‌صفحه‌و‌انتخاب‌گزینه‌-4

با‌استفاده‌از‌کلیدهای‌جهت‌نما-5

سوندیرسم فنی ساختمان، مهندس محمد شاه
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2-1
سیستم‌مختصاتی‌کارتزین‌یا‌دکارتی‌•

2-2
سیستم‌مختصاتی‌پلار‌یا‌قطبی‌•

سوندیرسم فنی ساختمان، مهندس محمد شاه
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باعثچونگیردمیقراراستفادهموردندرتبهسیستماینروازاینکنند،محاسبه(UCS)مبدابهنسبترانقاطتمامیمختصاتبایستیکاربرانسیستمایندر
(.استدوربینباکاروبردارینقشهدردستوراینبیشترکاربرد).شودمیپروژهپیشرفتکندی

مختصاتی کارتزین یا دکارتی سیستم 2-1

.کندمیدر‌غیر‌این‌صورت‌نسبت‌به‌مبدا‌مختصات‌رسم‌کند‌میقبل‌رسم‌ی‌نقطهبعدی‌را‌نسبت‌به‌ی‌نقطهAutoCAD،‌قرار‌دهیم@اگر‌قبل‌از‌مختصات‌دهی‌

.قبل‌از‌نقاط‌نداریم@فعال‌باشد،‌نیازی‌به‌نوشتن‌F12در‌صورتی‌که‌کلید‌

سوندیرسم فنی ساختمان، مهندس محمد شاه
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.کندحرکت0،90،۱80،270زوایایدرتنهاخطتاکردهفعالراOrthoیگزینهتوانمیسیستمدراین

:نمودعملزیرصورتدوبهتوانمیOrthoگزینهنمودنفعالبرای

F8فشردن‌کلید‌-۱

.‌نوار‌وضعیتدر‌کلیک‌بر‌روی‌گزینه‌ی‌-2

را‌پایین‌نگه‌داشته‌تا‌خط‌تنها‌در‌راستای‌(‌Shift)عمل‌نمود‌که‌پس‌از‌کلیک‌در‌صفحه‌کلید‌توان‌میعمودی‌به‌این‌صورت‌نیز‌یا‌افقی‌برای‌رسم‌خطوط‌

.یا‌عمودی‌حرکت‌کندافقی‌

سوندیرسم فنی ساختمان، مهندس محمد شاه
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مختصاتی پلار یا قطبی سیستم 2-2

مبداونظرموردینقطهواصلخطبینیزاویه)αو(مختصاتمبداازنقطهیفاصله)rپارامتردوبهقطبیمختصاتدستگاهدرنقطهیکنمودنمشخصبرای
.(شکلمطابق)داریمنیاز(هاXمحورمثبتجهتبامختصات

سپسوخططولابتدافرمانخطجلویدرمنظوراینبه
زیرصورتبه(<)علامتیکباراهاXمحورباآنیزاویه
.کنیممیوارد

سوندیرسم فنی ساختمان، مهندس محمد شاه
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Line:نام دستور

:زبانه

Draw  ->  Line

:آیکن :حرف خلاصه

L

1-Line 

.کردمهارراخطکشسانیوکارتزینپلار،مانندمختصاتیهایسیستمکمکبهآناجرایازپستوانمیکهشودمیاستفادهخطوطترسیمبرایدستورایناز

سوندیرسم فنی ساختمان، مهندس محمد شاه
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2-Erase

Erase:نام دستور

:زبانه

Modify ->  Erase

:آیکن :حرف خلاصه

E

.شودمیاز‌این‌دستوربرای‌پاک‌کردن‌موضوعات‌استفاده‌

سوندیرسم فنی ساختمان، مهندس محمد شاه
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کنیممیارائه‌شده‌در‌زیر‌عمل‌های‌روشمنظور‌انتخاب‌و‌حذف‌موضوعات‌به‌یکی‌از‌به‌

که‌با‌کوچکترین‌برخورد‌این‌پنجره‌با‌موضوعات‌،آنها‌را‌مورد‌انتخاب‌قرار‌شود‌میپس‌از‌کلیک‌در‌صفحه‌موس‌را‌به‌سمت‌چپ‌حرکت‌دهید‌مستطیل‌سبز‌ظاهر‌اگر‌-۱
.دهدمیمورد‌انتخاب‌قرار‌گیرد‌میکه‌تنها‌موضوعاتی‌را‌که‌کاملاً‌درون‌آن‌قرار‌شود‌میصورت‌حرکت‌موس‌به‌سمت‌راست‌مستطیل‌آبی‌ظاهر‌در‌.‌دهدمی

2-Allموضوعات‌ی‌همهیا‌
Eraseاجرای دستور 

در خط فرمانAllتایپ 

Enterزدن دو بار کلید 

تمامی موضوعات پاک می شود

3-Lastیا‌آخرین‌موضوع

Eraseاجرای دستور 

در خط فرمانLastتایپ 

Enterزدن دو بار کلید 

آخرین موضوع پاک می شود

را‌فشار‌داده‌تا‌موضوعات‌انتخابی‌Deleteپس‌از‌انتخاب‌آنها‌کلید‌توان‌میبرای‌پاک‌کردن‌موضوعات‌
.پاک‌شوند

سوندیرسم فنی ساختمان، مهندس محمد شاه
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بازگرداندن‌موضوعاتهای‌روش
Erase

E: حرف خلاصه •

پاک کردن موضوعات:عملکرد•

Undo

U:حرف خلاصه•

Ctrl+z:کلید ترکیبی •

eraseبازگرداندن موضوعات پاک شده توسط : عملکرد•

Redo

---:حرف خلاصه•

Ctrl+y:کلید ترکیبی •

بازگرداندن آخرین موضوع پاک شده:عملکرد •

به‌توانند‌میکاربران‌شودکه‌میبه‌صورت‌زیر‌ظاهر‌ای‌پنجرهMredoپس‌از‌اجرای‌دستور‌
.یکی‌از‌دو‌صورت‌زیر‌برای‌بازگرداندن‌اطلاعات‌عمل‌نمایند

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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3-Polyline

Polyline:دستورنام 

:زبانه

Draw -> Polyline

:آیکن :حرف خلاصه

Pl

.این‌دستور‌بعد‌از‌اجرا‌دارای‌پارامترهایی‌به‌شرح‌زیر‌است.‌شودمیبرای‌ترسیم‌خطوط‌متصل‌به‌هم‌استفاده‌

۱-arc:حرفازخطبهکمانبازگشتبرایوکردهکمانبهتبدیلراخطLمخففکهLineکنیممیاستفادهاست.
2-Length:خططولکردنواردبرایPolylineشودمیاستفاده.
3-Width & half Width:کهتفاوتاینباکندمیعریضراخطپارامتر،دوهرhalf widthبرابردوعرضیWidthکندمیایجاد

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه



159

4-Explode

Explode:نام دستور

:زبانه

Modify -> Explode     

:آیکن :حرف خلاصه

X

ویرایشیدستوراتتازنیممیراستکلیکسپسکردهانتخابراموضوعابتداکاراینبرای.شودمیاستفادهراسقسمتازموضوعاتنمودنجدابرای
.شوداعمالهاآنروی

سوندیرسم فنی ساختمان، مهندس محمد شاه
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5-Xline

Xline:نام دستور

:زبانه

Draw  ->  Xline

:آیکن :حرف خلاصه

Xl

.استزیر‌پارامتر‌5که‌دارای‌شود‌میبرای‌ترسیم‌خط‌دو‌سر‌نا‌محدود‌استفاده‌

سوندیرسم فنی ساختمان، مهندس محمد شاه
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6-Ray 

Ray:نام دستور

:زبانه

Draw-> Ray

:آیکن :حرف خلاصه

---

.گیردمیمورد‌استفاده‌قرار‌ها‌در‌نقشهراهنماکه‌به‌عنوان‌خط‌گویند‌میبه‌آن‌خط‌یک‌سر‌نامحدود‌

سوندیرسم فنی ساختمان، مهندس محمد شاه
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7-Point

Point:نام دستور

:زبانه

Draw ->  Point

:آیکن :حرف خلاصه

PO

سوندیرسم فنی ساختمان، مهندس محمد شاه



163

8-Circle

Circle:نام دستور

:زبانه

Draw -> Circle

:آیکن :حرف خلاصه

C

سوندیرسم فنی ساختمان، مهندس محمد شاه
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Polygon:نام دستور

:زبانه

Draw ->  Polygon

:آیکن :حرف خلاصه

Pol

9-Polygon

)Number of sides )تعداد‌اضلاع‌

(Center of Polygon )مرکز‌چند‌ضلعی‌

(Circumscribed about circle)محیطی‌

(Inscribed in circle)محاطی‌

(EDGE)ضلع‌

FIREST POINT 

نقطه‌اول

SECEND POINT

نقطه‌دوم‌

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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10-Copy

Copy:نام دستور

:زبانه

Modify -> Copy

:آیکن :حرف خلاصه

Co-Cp

سوندیرسم فنی ساختمان، مهندس محمد شاه
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11-Move 

Move:نام دستور

:زبانه

Modify -> Move

:آیکن :حرف خلاصه

M

سوندیرسم فنی ساختمان، مهندس محمد شاه
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12-Mirror

Mirror:نام دستور

:زبانه

Modify ->  Mirror

:آیکن :حرف خلاصه

MI

سوندیرسم فنی ساختمان، مهندس محمد شاه
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13-Offset

Offset:نام دستور

:زبانه

Modify ->  Offset

:آیکن :حرف خلاصه

O

سوندیرسم فنی ساختمان، مهندس محمد شاه
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14-Trim

Trim:نام دستور

:زبانه

Modify         Trim

:آیکن :حرف خلاصه

Tr

سوندیرسم فنی ساختمان، مهندس محمد شاه
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15-Extend

Extend:نام دستور

:زبانه

Modify  ->  Extend

:آیکن :حرف خلاصه

EX

سوندیرسم فنی ساختمان، مهندس محمد شاه
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16-Break at Point

Break at Point:نام دستور

:زبانه

Modify -> Break at Point

:آیکن :حرف خلاصه

---

سوندیرسم فنی ساختمان، مهندس محمد شاه
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17-Break

Break:  نام دستور

:زبانه

Modify  -> Break

:آیکن :حرف خلاصه

BR

سوندیرسم فنی ساختمان، مهندس محمد شاه
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18-Join 

Join:  نام دستور

:زبانه

Modify  ->  Join   

:آیکن :حرف خلاصه

J

سوندیرسم فنی ساختمان، مهندس محمد شاه
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19-Object Snap

می
سی

 تر
ک

کم
ی 

رها
بزا

ا

Object 
Snap

O
b

je
ct

 S
n

ap آیکن

O
b

je
ct

 S
n

ap حرف خلاصه

OS   

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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:ها Object snapروش های دسترسی به 

سوندیرسم فنی ساختمان، مهندس محمد شاه
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Object Snapدسترسی به جدول های روش

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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Polar Array Rectangular Array

Path Array

سوندیرسم فنی ساختمان، مهندس محمد شاه
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20-Polar Array

Polar Array:نام دستور

:زبانه

Modify ->  Array  ->   

Polar Array

:آیکن :دستور
ARRAYPOLAR

سوندیرسم فنی ساختمان، مهندس محمد شاه
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20-Polar Array

سوندیرسم فنی ساختمان، مهندس محمد شاه
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21-Rectangular Array 

 Rectangular Array:نام دستور

:زبانه

Modify -> Array ->    
Rectangular Array       

:آیکن :حرف خلاصه
ARRAYRECT

سوندیرسم فنی ساختمان، مهندس محمد شاه
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22-Path Array

Path Array:نام دستور

:زبانه

Modify  ->  PATH ARRAY

:آیکن :حرف خلاصه
ARRAYPATH

سوندیرسم فنی ساختمان، مهندس محمد شاه
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22-Path Array

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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Technical drawing pen size: 

https://www.designingbuildings.co.uk/wiki/Paper_Sizes

Note: m ISO = metric ISO

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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Layers

لایه ها()  آیکن 

.اندگرفتهشفافی بوده که بر روی هم قرار های ی کاغذمنزلهلایه ها در نرم افزار اتوکد به 

5-38Layers

سوندیرسم فنی ساختمان، مهندس محمد شاه
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 هالایهطریقه ی ایجاد و ویرایش

سوندیرسم فنی ساختمان، مهندس محمد شاه
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1-New layer : شودمیجدید استفاده ی لایهبه منظور ایجاد یک.

2-Delete layer : شودمیاستفاده ها لایهبرای پاک کردن.

سوندیرسم فنی ساختمان، مهندس محمد شاه
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3-Name : برای معرفی نام لایه استفاده می شود که می توانیم با زدن کلیدF2 دابل کلیک بر روی آن، نام لایه را تغییر دهیمیا.

4-Turns layer on or off:شودمیاستفادههالایهکردنروشنیاخاموشمنظوربهآیکونایناز.

5-Freeze or thaws :ا به به معنای فریز کردن یا ذوب کردن می باشد و اجازه می دهد تا لایه ها ر
.طور موقت مخفی کرده یا نمایان کنیم

Turnتفاوت Layer on or offباFreeze or thaws؟؟؟چیستدر

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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ISO 128-50

سوندیرسم فنی ساختمان، مهندس محمد شاه
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5-23Hatch 

Hatch:نام دستور

:زبانه

Draw ->  Hatch

:آیکن :حرف خلاصه

H

(زیرهمانند شکل.)به منظور ایجاد هاشور بر روی موضوعات استفاده می شود: Hatchسربرگ

سوندیرسم فنی ساختمان، مهندس محمد شاه
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:شوندمیتقسیمدسته2بهاتوکددرهاهاشور

درآمادهصورتبههاشورهااین:Predefinedیاایکتابخانههاشورهای-1
.دارندوجودمتنوعالگوهایبااتوکد

:باشدمیزیرصورتبههاالگواینبهدسترسیینحوه

.کلیک نماییدOKاز پنجره ی ظاهر شده موضوع مورد نظر را انتخاب کرده و بر روی 

.باشدمیصافخطصورتبهتنهاونداشتهالگوییهیچ:سادههاشورهای-2

سوندیرسم فنی ساختمان، مهندس محمد شاه
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.برای تعیین زاویه و مقیاس می توانید به یکی از دو صورت زیر عمل نمایید

سوندیرسم فنی ساختمان، مهندس محمد شاه
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(pick point):بازمرزهایدرونوشدهاستفادهبستهمرزهایبرایفقطerrorدهدمی.

(Select object):شودمیاستفادهبازمرزهایبرایهموبستهمرزهایبرایهم.

عات  موضوکنیم، برای انتخاب موضوعات تودرتو استفاده Select objectدر صورتی که از
.یکی در میان هاشور می خورند

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه



207

تودرتومرزهایدرزدنهاشوریطریقه

سوندیرسم فنی ساختمان، مهندس محمد شاه
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 سربرگgradient : شودمیبه منظور ایجاد هاشورهای رنگ بر روی موضوعات استفاده.
:روش اجرا

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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:هاشورهاویرایشیطریقه

Hatchیگزینهوکردهراستکلیکآنرویهاشورها،انتخابازپس-1 Editکنیممیانتخابرا.

.کنیممیکلیکدابلهاشورهارویبر-2

سوندیرسم فنی ساختمان، مهندس محمد شاه
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Dtextیا Text:نام دستور

:زبانه

Draw  ->  Text -> 

Single Text Line

:آیکن :حرف خلاصه

T یاDT

5-24DTEXT 

.شودمیاستفادهصفحهدرونبهمتنکردنواردبرایدستورایناز

Altترکیبیکلیداز.دادخاتمهمتنبهآنفشردنباردوباورفتهجدیدسطربهEnterکلیدباریکفشردنباتوانمیتایپهنگامدر + Shiftتغییربرایتوانمینیز
.کرداستفادهنوشتاریزبان

سوندیرسم فنی ساختمان، مهندس محمد شاه
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.گیرندمیصفحه مورد استفاده قرار متن درون تنظیم است که برای به صورت زیر هایی گزینهاین پارامتر دارای Justify:پارامتر 

.دهدمیبوده که با گرفتن دو نقطه، متن را بین آنها قرار Fitاز مهمترین گزینه های آن پارامتر

.کنیداجراراDTEXTدستور-1

.را انتخاب کنید Justifyپارامتر -2

.را انتخاب کنیدFitی گزینه-3

.ی اول را مشخص کنیدنقطه -4

.مشخص کنیددوم را ی نقطه -5

سوندیرسم فنی ساختمان، مهندس محمد شاه
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Right))راستCenter))وسطLeft))چپ***

TRTCTLTop))بالا

MRMCMLMiddle))وسط

BRBCBLBottom))پایین

.نماییدواردراصفرمقداروکردهاجراراMirrtextدستورشد،قرینهنیزهانوشتهMirrorدستورازاستفادههنگامدرکهصورتیدر

سوندیرسم فنی ساختمان، مهندس محمد شاه
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5-25STYLE

Style:نام دستور

:زبانه

Format  ->  Text 
Style

:آیکن :حرف خلاصه

ST

سوندیرسم فنی ساختمان، مهندس محمد شاه
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ازکهصورتیدرverticalیگزینه
استفادهshxپسوندباهاییفونت
.استفعالکنیممی

سوندیرسم فنی ساختمان، مهندس محمد شاه



216

Mtext:نام دستور

:زبانه

Draw -> Text ->

Multiline Text

:آیکن :حرف خلاصه

MT

5-26Mtext

.گیرد میاین دستور برای نوشتن متن با امکانات بیشتر مورد استفاده قرار 

.بزنیدEnterوکردهتایپفرمانخطدرراMTدستور-1

.کنیدکلیکصفحهدردلخواهمحلدر-2

.کنیدانتخابرامستطیلراسازدومینقطه-3

سوندیرسم فنی ساختمان، مهندس محمد شاه
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.کندایجادمتندررانیازموردتغییراتتادهدمیراامکاناینکاربربهکهشدهظاهرزیرصورتبهایپنجرهدومینقطهانتخابازپس

سوندیرسم فنی ساختمان، مهندس محمد شاه
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انتخابراتصویریکاراکترهایتوانیممیwحروفبخشازکهشدهظاهرجدولیکنیمانتخابراOtherیگزینهSymbolرویبرکلیکازپسکهصورتیدر
.کنیمواردصفحهدرونبههاآنcopyیدکمهزدنباوکرده

سوندیرسم فنی ساختمان، مهندس محمد شاه
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23-Arc

 Arc:نام دستور

:زبانه

Draw  -> Arc

:آیکن :حرف خلاصه

A

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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24-Scale

Scale:  نام دستور

:زبانه

Modify ->  Scale

:آیکن :حرف خلاصه

SC

سوندیرسم فنی ساختمان، مهندس محمد شاه
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Scale:  نام دستور

:زبانه

Modify ->  Scale

:آیکن :حرف خلاصه

SC

24-Scale

سوندیرسم فنی ساختمان، مهندس محمد شاه
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25-Rotate

Rotate:  نام دستور

:زبانه

Modify         Rotate

:آیکن :حرف خلاصه

RO

سوندیرسم فنی ساختمان، مهندس محمد شاه
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25-Rotate

Rotate:  نام دستور

:زبانه

Modify  -> Rotate

:آیکن :حرف خلاصه

RO

سوندیرسم فنی ساختمان، مهندس محمد شاه
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26-Rotate

Rotate:  نام دستور

:زبانه

Modify -> Rotate

:آیکن :حرف خلاصه

RO

سوندیرسم فنی ساختمان، مهندس محمد شاه
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D
es

ig
n

 C
en

te
r آیکن

D
es

ig
n

 C
en

te
r

بیکلید ترکی

Ctrl+2 D
es

ig
n

 C
en

te
r

حرف خلاصه

DC   

Design Centerایناجرایازپس.باشدمیاتوکددرونآمادهالگوهایازبسیاریمرکز
.نمودواردصفحهدرونبهراموضوعاتزیرصورتبهتوانمیدستور

27-Design Center

سوندیرسم فنی ساختمان، مهندس محمد شاه
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DRAGیوسیلهبهرانظرموردترسیمات،Blockقسمتازنهایتدر & DRAWکنیدواردصفحهدرونبه.

سوندیرسم فنی ساختمان، مهندس محمد شاه
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28-Tool Palettes
To

o
l P

al
et

te
s آیکن

To
o

l P
al

et
te

s

بیکلید ترکی

Ctrl+3 To
o

l P
al

et
te

s

حرف خلاصه

TP   

Tool Palettesخودنظرموردهایمدلاجرا،ازبعدبتوانندکاربرانتاشدهباعث
مدلباهامدلاینتفاوتاستذکربهلازم.کنندفراخوانیصفحهدرونبهرا

یآبمثلثعلامتیکنمادهااینازیکهرانتخابباکهاستایندرDCهای
ازمختلفیهایمدلبتوانندکاربراندهدمیاجازهکهشدهظاهرهاآنکناردر
.گویندمیپویاهامدلاینبهدلیلهمینبهکنند،مشاهدراالگوآن

سوندیرسم فنی ساختمان، مهندس محمد شاه



229

29-Chamfer

 Chamfer:نام دستور

:زبانه

Modify -> Chamfer

:آیکن :حرف خلاصه

Cha

سوندیرسم فنی ساختمان، مهندس محمد شاه
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29-Chamfer

 Chamfer:نام دستور

:زبانه

Modify -> Chamfer

:آیکن :حرف خلاصه

Cha

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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30-Fillet

 Fillet:نام دستور

:زبانه

Modify ->  Fillet

:آیکن :حرف خلاصه

F

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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31-Stretch

 Stretch:نام دستور

:زبانه

Modify -> Stretch

:آیکن :حرف خلاصه

S

سوندیرسم فنی ساختمان، مهندس محمد شاه
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32-BLEND CURVES

 BLEND CURVES:نام دستور

:زبانه

Modify -> Blend
Curves

:آیکن :حرف خلاصه

--

سوندیرسم فنی ساختمان، مهندس محمد شاه
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رسم اشکال ایزومتریک

سوندیرسم فنی ساختمان، مهندس محمد شاه
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تصاویر مجسم

https://rockbench.ir/drawing-10/

.شوندمیزاویه محورها به سه دسته تقسیم تصاویر مجسم بر اساس

سوندیرسم فنی ساختمان، مهندس محمد شاه
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تغییر جهت خطوط شبکه برای ترسیم تصاویر ایزومتریک 

سوندیرسم فنی ساختمان، مهندس محمد شاه
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ترسیم دایره ایزومتریک 

Ellipse:  نام دستور

:زبانه

Draw ->  ellipse

:آیکن :حرف خلاصه

El

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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ترسیم در محیط سه بعدی اتوکد

سوندیرسم فنی ساختمان، مهندس محمد شاه
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انجام تنظیمات محیط سه بعدی

سوندیرسم فنی ساختمان، مهندس محمد شاه
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ابزار ترسیم اشکال مختلف سه بعدی

سوندیرسم فنی ساختمان، مهندس محمد شاه
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ابزار افزایش و کاهش حجم

سوندیرسم فنی ساختمان، مهندس محمد شاه
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ابزار افزایش و کاهش حجم

سوندیرسم فنی ساختمان، مهندس محمد شاه
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ابزار برش احجام

سوندیرسم فنی ساختمان، مهندس محمد شاه
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ابزارهای ویرایش

،Moveسایر ابزارهای ویرایش مورد بحث در ترسیم دو بعدی نظیر  
Copy،Offsetو غیره در محیط دوبعدی نیز کاربرد دارند.

Copy Move Rotate

سوندیرسم فنی ساختمان، مهندس محمد شاه
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ابزاریکپارچه سازی

.برای ادغام چند شکل و تولید یک جسم یکپارچه کاربرد دارد

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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Rotate:  نام دستور

:زبانه

Modify  -> Rotate

:آیکن :حرف خلاصه

RO

سوندیرسم فنی ساختمان، مهندس محمد شاه
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ساختمان اسکلت فولادی: ایهای سازهترسیم المان

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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مجهول یابی

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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آنالیز سطوح

سوندیرسم فنی ساختمان، مهندس محمد شاه



269
صفحه نوع اول

صفحه نوع دوم

صفحه نوع سوم

سوندیرسم فنی ساختمان، مهندس محمد شاه
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:هقوانین حاکم بین دو صفح

:قوانین حاکم بین صفحه و خط

.دارای محدوده یکسان باشند-1

.ها در هر دو تصویر یکسان باشدتعداد گوشه-2

.دهر دو گوشه متناظر بر روی یک رابط باشن-3

.هر دو شکل از نظر هندسی متشابه باشند-4

.دارای محدوده یکسان باشند-1

ط  ها در صفحه با تعداد انفصال در ختعداد رابط-2

.برابر باشد

ر روی هر گوشه و نقطه انفصال متناظر ب-3

.یک رابط باشند
برگرفته از طرح درس آقای مهندس مهدی ایمان

سوندیرسم فنی ساختمان، مهندس محمد شاه
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:هقوانین حاکم بین دو صفح

:قوانین حاکم بین صفحه و خط

.دارای محدوده یکسان باشند-1

.ها در هر دو تصویر یکسان باشدتعداد گوشه-2

.دهر دو گوشه متناظر بر روی یک رابط باشن-3

.هر دو شکل از نظر هندسی متشابه باشند-4

.دارای محدوده یکسان باشند-1

ط  ها در صفحه با تعداد انفصال در ختعداد رابط-2

.برابر باشد

ر روی هر گوشه و نقطه انفصال متناظر ب-3

.یک رابط باشند
برگرفته از طرح درس آقای مهندس مهدی ایمان

سوندیرسم فنی ساختمان، مهندس محمد شاه
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برگرفته از طرح درس آقای مهندس مهدی ایمان

سوندیرسم فنی ساختمان، مهندس محمد شاه
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برگرفته از طرح درس آقای مهندس مهدی ایمان

سوندیرسم فنی ساختمان، مهندس محمد شاه
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برگرفته از طرح درس آقای مهندس مهدی ایمان

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه



278

:هقوانین حاکم بین دو صفح

.دارای محدوده یکسان باشند-1

.ها در هر دو تصویر یکسان باشدتعداد گوشه-2

.دهر دو گوشه متناظر بر روی یک رابط باشن-3

.هر دو شکل از نظر هندسی متشابه باشند-4

سوندیرسم فنی ساختمان، مهندس محمد شاه
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:هقوانین حاکم بین دو صفح

.دارای محدوده یکسان باشند-1

.ها در هر دو تصویر یکسان باشدتعداد گوشه-2

.دهر دو گوشه متناظر بر روی یک رابط باشن-3

.اشندهر دو شکل از نظر هندسی متشابه ب-4

.اشنداضلاع موازی با هم در نمای دیگر نیز موازی ب4-1

.ر باشندنسبت اضلاع موازی در دو نما براب4-2

سوندیرسم فنی ساختمان، مهندس محمد شاه



280

:هقوانین حاکم بین دو صفح

.دارای محدوده یکسان باشند-1

.ها در هر دو تصویر یکسان باشدتعداد گوشه-2

.دهر دو گوشه متناظر بر روی یک رابط باشن-3

.اشندهر دو شکل از نظر هندسی متشابه ب-4

.اشنداضلاع موازی با هم در نمای دیگر نیز موازی ب4-1

.ر باشندنسبت اضلاع موازی در دو نما براب4-2

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه



282

انواع برش

برش ساده یا برش کامل-1

برش مرکب یا برش شکسته قائم-2

برش متوالی یا پشت سر هم-3

برش شعاعی یا برش شکسته مایل-4

برش خاص-5

برش گردشی یا چرخشی یا دورانی-6

برش موضعی-8

برش جابجایی-7

نیم برش-9

سوندیرسم فنی ساختمان، مهندس محمد شاه



283

انواع برش

برش ساده یا برش کامل-1

برش مرکب یا برش شکسته قائم-2

برش متوالی یا پشت سر هم-3

برش شعاعی یا برش شکسته مایل-4

برش خاص-5

برش گردشی یا چرخشی یا دورانی-6

برش موضعی-8

برش جابجایی-7

نیم برش-9

سوندیرسم فنی ساختمان، مهندس محمد شاه



284

انواع برش

برش ساده یا برش کامل-1

برش مرکب یا برش شکسته قائم-2

برش متوالی یا پشت سر هم-3

برش شعاعی یا برش شکسته مایل-4

برش خاص-5

برش گردشی یا چرخشی یا دورانی-6

برش موضعی-8

برش جابجایی-7

نیم برش-9

سوندیرسم فنی ساختمان، مهندس محمد شاه
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انواع برش

برش ساده یا برش کامل-1

برش مرکب یا برش شکسته قائم-2

برش متوالی یا پشت سر هم-3

برش شعاعی یا برش شکسته مایل-4

برش خاص-5

برش گردشی یا چرخشی یا دورانی-6

برش موضعی-8

برش جابجایی-7

نیم برش-9

سوندیرسم فنی ساختمان، مهندس محمد شاه
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انواع برش

برش ساده یا برش کامل-1

برش مرکب یا برش شکسته قائم-2

برش متوالی یا پشت سر هم-3

برش شعاعی یا برش شکسته مایل-4

برش خاص-5

برش گردشی یا چرخشی یا دورانی-6

برش موضعی-8

برش جابجایی-7

نیم برش-9

سوندیرسم فنی ساختمان، مهندس محمد شاه



287

انواع برش

برش ساده یا برش کامل-1

برش مرکب یا برش شکسته قائم-2

برش متوالی یا پشت سر هم-3

برش شعاعی یا برش شکسته مایل-4

برش خاص-5

برش گردشی یا چرخشی یا دورانی-6

برش موضعی-8

برش جابجایی-7

نیم برش-9

سوندیرسم فنی ساختمان، مهندس محمد شاه
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انواع برش

برش ساده یا برش کامل-1

برش مرکب یا برش شکسته قائم-2

برش متوالی یا پشت سر هم-3

برش شعاعی یا برش شکسته مایل-4

برش خاص-5

برش گردشی یا چرخشی یا دورانی-6

برش موضعی-8

برش جابجایی-7

نیم برش-9

سوندیرسم فنی ساختمان، مهندس محمد شاه
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انواع برش

برش ساده یا برش کامل-1

برش مرکب یا برش شکسته قائم-2

برش متوالی یا پشت سر هم-3

برش شعاعی یا برش شکسته مایل-4

برش خاص-5

برش گردشی یا چرخشی یا دورانی-6

برش موضعی-8

برش جابجایی-7

نیم برش-9

سوندیرسم فنی ساختمان، مهندس محمد شاه



290

انواع برش

برش ساده یا برش کامل-1

برش مرکب یا برش شکسته قائم-2

برش متوالی یا پشت سر هم-3

برش شعاعی یا برش شکسته مایل-4

برش خاص-5

برش گردشی یا چرخشی یا دورانی-6

برش موضعی-8

برش جابجایی-7

نیم برش-9

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه



299

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه



304

گذاریاندازه

سوندیرسم فنی ساختمان، مهندس محمد شاه
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گذاریاصول اندازه

.ها خودداری شوداز تکرار اندازه-1
.ای نباید کم باشدهیچ اندازه-2
.ها در اطراف تصویر پخش شونداندازه-3
.توان عمل نموداگر فضای کافی وجود ندارد به صورت زیر می-4
.تواند به خط اصلی تکیه کندفلش می-5
.تواند به خط ندید تکیه کندفلش می-6
.کنیماستفاده میRبرای نمایش شعاع همیشه از حرف -7
.کنیماستفاده میφبرای نمایش قطر همواره از -9
توان به جای خط اندازه استفاده از خطوط اصلی و محور تقارن نمی-8

.توان از آن به عنوان خط رابط اندازه یا کمکی بهره گرفتولی می. کرد
.کنیماستفاده می□برای نمایش مقطع مربع، از علامت -9

های افقی، در وسط خط اندازه و بالای آن گذاری، اندازهدر اندازه-10
.شودنوشته می

های عمودی در سمت چپ خط اندازه نوشته  گذاری، اندازهدر اندازه-11
.ای که از سمت راست خوانده شودشود، به گونهمی
های اندازه پشت  فاصله خط اندازه تا خط اصلی و همچنین فاصله خط-12

.میلی متر است7/5سر هم 
.شوندتر اول نوشته میهای کوچکگذاری همیشه اندازهدر اندازه-13

سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه
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سوندیرسم فنی ساختمان، مهندس محمد شاه



308

سوندیرسم فنی ساختمان، مهندس محمد شاه



309

گذاریانواع اندازه

ایگذاری پلهاندازه

سوندیرسم فنی ساختمان، مهندس محمد شاه
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گذاریانواع اندازه

ایگذاری زنجیرهاندازه

سوندیرسم فنی ساختمان، مهندس محمد شاه
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گذاری زوایااندازهگذاری روی شیباندازه

سوندیرسم فنی ساختمان، مهندس محمد شاه



312

ها، وتر و زوایاگذاری قوساندازه

سوندیرسم فنی ساختمان، مهندس محمد شاه



313

هاگذاری پخاندازه
گذاری قطعات کرویاندازه

سوندیرسم فنی ساختمان، مهندس محمد شاه



314

های مشابهگذاری سوراخاندازهگذاری قطعات نازکاندازه

سوندیرسم فنی ساختمان، مهندس محمد شاه



315

گذاری برای قطعات با خط شکستگیاندازه

سوندیرسم فنی ساختمان، مهندس محمد شاه


